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1 Welcome to the World of GUITAR RIG!

 

GUITAR RIG KONTROL is the complete solution for guitar and bass players. The stage-ready
RIG KONTROL foot pedal integrates seamlessly with the GUITAR RIG software and provides
studio-quality sound with its built-in audio interface. It is designed and optimized for GUITAR
RIG, but as it complies with industry standards and features full MIDI support, it works per-
fectly with most professional audio software.

The RIG KONTROL connects to your computer via high-speed USB 2.0, which also provides its
power supply. It features two inputs, suited either for instrument or line level signals. A two-
channel line-out connects to your monitoring system, and a stereo jack allows for headphone
monitoring at an independent volume.

As a controller, the RIG KONTROL offers nine switches and a pedal, giving you control over
almost all of GUITAR RIG’s functions. Moreover, it features MIDI connections as well as two
analogue inputs to connect external controllers.

In the following chapters, you will learn more about the RIG KONTROL and how to make the
best use of it. Please read this manual carefully in order to get acquainted with the product.

Welcome to the World of GUITAR RIG!
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2 Before You Start – Important Notes

 

First things first; before using GUITAR RIG, it is advised that you read this chapter carefully.

2.1 Serial Numbers and Nameplate
 

GUITAR RIG Kontrol comes with two serial numbers. The RIG KONTROL's serial number can
be found on the bottom of the hardware, along with the nameplate listing the product model
name and other technical information. The serial number for activating GUITAR RIG is located
on the sleeve of the product DVD.

2.2 Using the Unit Safely
 

Please read the following instructions thoroughly to prevent from health risks and damaging
the product.

2.2.1 Warning
 

To prevent hearing damage, please observe the following warnings:

▪ This Product, in combination with an amplifier, headphones, or speakers can produce
sounds in decibel ranges that may cause hearing damage.

▪ For protection, set all volume levels to a minimum before using the RIG KONTROL. Grad-
ually raise the volume controls while music is playing to set the desired listening level.

▪ Do not operate it at high volume levels for long periods. If you experience any hearing
problems or ringing in the ears, consult an audiologist immediately.

2.2.2 Caution
 

To make sure that the RIG KONTROL or any device connected is not damaged during usage or
maintenance, it is important that you observe the following rules:

Before You Start – Important Notes
Serial Numbers and Nameplate
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▪ Do not open the device or attempt to disassemble or modify the internal parts. The device
contains no user-serviceable parts. If it appears to be malfunctioning, discontinue use im-
mediately and have it inspected by qualified service personnel.

▪ Do not expose the unit to rain, use it near water or in damp or wet conditions.

▪ Do not allow any objects or liquids of any kind to penetrate the unit.

▪ Never use or store the unit in areas that are subject to temperature extremes (e.g., direct
sunlight in an enclosed vehicle or near heat-generating equipment) or high levels of vibra-
tion.

▪ Do not place the RIG KONTROL in an unstable position where it is possible the unit could
accidentally fall. Remove all connected cables before moving the unit.

▪ Before turning the power on or off for any component, set all volume levels to their mini-
mum.

▪ Do not use excessive force on the knobs or connectors.

▪ When cleaning the RIG KONTROL, use a soft, dry cloth. Never use paint thinners, sol-
vents, cleaning fluids or chemical-impregnated wiping cloths.

2.2.3 Disposal Notice
 

Should this product become damaged beyond repair, or if you wish to dispose it, please ob-
serve the regulations of your area and country that relate to the disposal of electronic products.

2.3 Disclaimer
 

Native Instruments GmbH cannot be held responsible for damage or lost or destroyed data
caused by improper use or modification to the RIG KONTROL.

The information contained in this manual is believed to be correct at the time of printing or
digital release. However, Native Instruments reserves the right to make changes to the specifi-
cations at any time without notice or obligation to update existing units.

Before You Start – Important Notes
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3 The RIG KONTROL Hardware

 

This section will give you an overview of the RIG KONTROL hardware.

3.1 Top Panel
 

The RIG KONTROL's top panel.

(1) The footswitches can be assigned in the software to perform tasks such as stepping through
presets, or turning individual components on and off. Each switch has an LED to indicate
whether it is activated. The top row is labeled with the most frequently used functions of GUI-
TAR RIG, matching their pre-configured assignments.

The RIG KONTROL Hardware
Top Panel
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(2) The expression pedal can be used to control any continuous parameter of the software,
such as volume or wah-wah. There is an additional freely assignable switch underneath the tip
of the pedal.

(3) Shows the number of the currently activated preset.

(4) This LED-Meter shows the level of the audio signal at the input. The red LEDs indicate
clipping and should never light up. Turn the according input gain down if it does.

(5) This LED-Meter shows the level of the audio signal at the output. The red LEDs indicate
clipping and should never light up. Turn the output level down if it does.

(6) This LED indicates that the RIG KONTROL is receiving MIDI signals from a sequencer or
from another controller.

(7) This LED shows whether the switch underneath the pedal is activated.

3.2 Rear Panel
 

The RIG KONTROL's rear panel.

(1) The Inst/Line switch sets the input sensitivity for Input 1 and 2. When depressed, the in-
puts will handle instrument signals such as a guitar or bass, when pressed, line level signals
are accepted. The selected input type is also indicated on the unit’s top.

(2) This knob controls the gain of input 1.

The RIG KONTROL Hardware
Rear Panel
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(3) The socket for Input 1 (¼" jack, TRS balanced) will accept line level or instrument level
signals, depending on the position of the Line/Inst switch. Connect a guitar, bass guitar, key-
board or the left channel of a stereo device.

(4) The socket for Input 2 (¼" jack, TRS balanced) will accept line level or instrument level
signals, depending on the position of the Line/Inst switch. Connect a second guitar, bass gui-
tar, keyboard or the right channel of a stereo device.

(5) This knob controls the gain of input 2.

(6) These jacks transmit the processed output from the audio interface. Connect both for ster-
eo sound.

(7) The output amplification can be set to full or –14 dB.

(8) Separately controls the volume of the headphones output.

(9) For connecting stereo headphones.

(10) For connecting external expression pedals, footswitches, volume pedals or switchboxes.

(11) The RIG KONTROL features a MIDI interface with one input and one output. The RIG
KONTROL does not require MIDI to send controller messages to GUITAR RIG, but it is able to
send MIDI signals to other applications.

(12) The USB port connects the unit to your computer. Your computer must support USB 2.0
in order to work with the hardware. The unit also relies on the USB bus power to function. Con-
nect this unit directly to your computer’s USB 2.0 port and avoid using un-powered USB hubs.
You should always secure the USB cable by wrapping it around the USB Hook.

The RIG KONTROL Hardware
Rear Panel

 

GUITAR RIG KONTROL - Manual - 12



4 Installation Under Windows

 

This chapter describes the installation of the RIG KONTROL hardware under Windows 7, fo-
cusing on the setup of the audio interface. To activate the foot pedal as a controller in GUITAR
RIG and to use its MIDI capabilities, please refer to ↑7, Using the RIG KONTROL as a Control-
ler Interface of this manual.

For detailed information about the GUITAR RIG software, please consult the Application Refer-
ence. You can find this on the product DVD or in the GUITAR RIG menu under Help > Open
Manual > Your Language.

4.1 Software Installation
 

Make sure you are logged in with administrator privileges. Don’t connect the RIG KONTROL
yet.

1. Browse the content of the product DVD and locate the setup file. If you are using a down-
load version of GUITAR RIG, you need to extract the setup files first.

Installation Under Windows
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2. Double-click the GUITAR RIG setup file ("Guitar Rig 5 [version number] Setup PC.exe") to
start the installation procedure.

3. Follow the on-screen instructions, which will guide you through the installation procedure.
It is advised to install the software to the default installation folders.

4. You will be asked to specify the path to the VST plug-in folder on your system. If you
don’t know what a VST plug-in is, or if you are sure you will be using GUITAR RIG in
stand-alone mode only, just use the standard setting. If you want to use GUITAR RIG as a

Installation Under Windows
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plug-in in a host software, you need to change the folder to your host software's plug-in
folder.

Installation Under Windows
Software Installation

 

GUITAR RIG KONTROL - Manual - 15



5. You will be asked if you want to install drivers for the GUITAR RIG audio interfaces. Put a
checkmark next to Install the Rig Kontrol 3 Driver and click Next.

6. If prompted, you may need to restart your computer upon completion.
The following applications have been placed onto your hard drive:

▪ The GUITAR RIG fully featured stand-alone software.

▪ The GUITAR RIG plug-ins: Use GUITAR RIG as a plug-in in your Digital Audio Workstation
(DAW) of choice. On Windows computers, GUITAR RIG supports the VST and the RTAS
plug-in formats.

▪ The Service Center: this application handles product activation as well as update manage-
ment. Please refer to the Setup Guide for details.

▪ The hardware drivers for the RIG KONTROL.

In case you want to install the hardware drivers only, a separate driver installer file is availa-
ble on the installation DVD. You can also download its latest version from the Support sec-
tion of the Native Instruments website.

Installation Under Windows
Software Installation
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4.2 Hardware Installation
 

Use the supplied USB cable to connect the RIG KONTROL directly to a USB 2.0 port on your
computer.

Connecting the controller to your computer.

The RIG KONTROL is powered via USB. Operation is guaranteed only with a USB 2.0 control-
ler as a single device or with self-powered USB 2.0 hubs.

► After successfully installing the driver, the RIG KONTROL will be recognized automatically.
If not, start the software installation again as explained above.

Several driver modules will be assigned to the RIG KONTROL now, each one causing a small
pop-up window notifying you of the installed driver.

On a Windows computer, the driver is associated with a particular USB port. If you plug the
USB cable into a different port than the one it was installed at, the driver assignment proc-
ess starts again.

If at any time the computer does not seem to recognize the RIG KONTROL, disconnect the
USB cable, wait a few seconds, then re-connect it. If the problem remains, restart your com-
puter with the interface connected.

Installation Under Windows
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4.3 Configuration
 

This chapter explains how to use the RIG KONTROL audio interface with Windows and particu-
larly with the GUITAR RIG software. It Is assumed that you have already activated GUITAR RIG
using the Service Center. If not, please refer to the Setup Guide for further information on reg-
istering your product.

4.3.1 Configuring GUITAR RIG
 

We will now set up GUITAR RIG to use the RIG KONTROL audio interface.

► Start the software before you proceed.

When the software is started for the first time, you will be prompted with the Audio and MIDI
Settings window automatically, where you need to make the following settings (to access these
settings later on, select File > Audio and MIDI Settings from the program menu:

The Audio and MIDI Settings window.

Installation Under Windows
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1. On the Audio tab, choose ASIO from the Driver drop-down menu.
2. Select RIG KONTROL 3 from the Device drop-down menu.
3. Choose a Sample Rate that is compatible with your music application and suited to your

computing power. Per default, the sample rate is set to 44100 Hz (CD-Quality). Higher
sample rates may improve sound quality, but cause a higher CPU load as well, and
44100 Hz is a very common setting.

If RIG KONTROL 3 does not appear in the list, something went wrong. Restart the installa-
tion as explained in ↑4.1, Software Installation.

Advanced Configuration

For advanced configuration settings using the driver control panel, please refer to ↑5.4, Audio
Connections and Levels.

4.3.2 Using the RIG KONTROL as Your Default Audio Interface
 

If you want to use the RIG KONTROL for playback of all audio applications on your computer
(not only for music software), you have to set it as your default audio interface. For Windows 7,
this works as follows:

1. Open Start > Control Panel > Hardware and Sound > Sound.
2. Select the Playback tab.
3. In the device list, select Rig Kontrol 3 Output and click on Set Default.
4. Select the Recording tab.
5. In the device list, select Rig Kontrol 3 Input and click on Set Default.

Installation Under Windows
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6. Click OK to close the dialog.

4.4 Audio Connections and Levels
 

In the following chapters you will learn how to connect your guitar and your monitoring system
to the RIG KONTROL and how to set the right amplification levels both on the hardware and
on the software side of your setup. Please start GUITAR RIG before proceeding.

4.4.1 Connecting Your Instrument and Adjusting the Input Level
 

1. Turn down the volume on your monitoring system to prevent hearing damages.

Installation Under Windows
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2. Make sure the input selector is set to instrument input amplification (LINE/INST button
on the back of the RIG KONTROL depressed) except if you are using a preamp to boost
your signal to line level.

3. Plug the cable connected to your guitar or bass into one of the input jacks of the RIG
KONTROL.

4. Completely turn down the volume of the input channel you are not using.
Keep in mind that for an instrument that generates a stereo signal, such as a synthesizer key-
board, you need to connect it to both input channels for stereo sound.

Connecting a guitar or bass guitar to the controller.

In order to achieve the best sound quality by providing the interface with a sufficiently power-
ful signal, you need to carefully adjust the input level of the RIG KONTROL. The Input Level
meter helps you identify the level of the incoming signal:

Meter Status Meaning

All LEDs are off No incoming signal

Green LEDs flashing Incoming signal

Green and red LEDs flash-
ing

Incoming signal is too loud

Before adjusting the input sensitivity, turn up the volume knob on your guitar. Strum some
chords at the volume level you are typically playing at and look at the Input Level meter:

Installation Under Windows
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1. Turn up the input level knob next to the input jack you chose, just until the meter is
reaching the red zone when you play.

2. At that point, slightly turn the knob down until you are safely in the green zone, even
when you are playing really powerful chords.

Now the input sensitivity is set to its optimum level, enabling the RIG KONTROL to provide the
highest dynamical range without clipping.

4.4.2 Connecting a Second Instrument
 

You can connect different instruments to both input channels, as long as they both provide a
signal at the same level (line or instrument). Just plug the cable of your second instrument into
the other input jack and set the right input level as described in the previous section.

If only one channel is used, set the other channel’s Gain knob to zero

For instruments generating a stereo signal, the second channel needs to be connected for ster-
eo sound.

4.4.3 The Input Level of GUITAR RIG
 

It is assumed that your guitar is connected to the RIG KONTROL and its input level is properly
adjusted (see ↑4.4.1, Connecting Your Instrument and Adjusting the Input Level). Now you
need to make sure that the input signal is processed at the right level by the software.

Please take a look at the header of the GUITAR RIG window: It consists of the input module
with channel selectors (L/R), a basic noise gate, the output module with a limiter and informa-
tion about the processing power consumed.

GUITAR RIG's software header.

Note that the Input meter shows an amplitude when you are playing. It also features an inte-
grated volume fader that controls the input level. Adjust it to achieve the highest possible level
for your signal without clipping. This is indicated by the Level meter getting close to the red
zone without actually hitting it.

Installation Under Windows
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If only one guitar is connected, GUITAR RIG will receive a mono signal. You can set up the
Input module to route your guitar signal to both channels. Per default, GUITAR RIG is set to
process both input channels (L + R are activated), so one of the input channels remains mute.
To change this, deactivate the channel you are not using: Click on the appropriate button (L or
R) on the left hand side of the Input meter once, so that only the input channel in use is ac-
tive. This will route the mono signal to both channels.

4.4.4 Connecting the Output
 

The RIG KONTROL provides two mono outputs to connect your monitoring system, be it a mix-
ing desk, a pair of active speakers or your home stereo. Mind that both of them have to be con-
nected for stereo sound. A separate stereo output (TRS) allows for connecting your head-
phones.

Connecting speakers and headphones to the controller.

1. Connect the output jacks to the input of your amp with its volume level turned down.
2. If you are using headphones, connect them to the output jack and put them on with the

headphone level fully turned down.
3. Go to the Preset Browser and select one of the presets by clicking on it.

Installation Under Windows
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4. Start playing and carefully turn up the volume of your amp or the headphone level of the
RIG KONTROL to the desired level.

You should be all set now, and ready to rock!

Installation Under Windows
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5 Installation under Mac OS X

 

This chapter describes the basic installation of the RIG KONTROL hardware under Mac OS X,
focusing on the setup of the audio interface. To activate the foot pedal as a controller in GUI-
TAR RIG and to use its MIDI capabilities, please refer to ↑7, Using the RIG KONTROL as a
Controller Interface of this manual.

For detailed information about the GUITAR RIG software, please consult the Application Refer-
ence. You can find it on the product DVD or in the GUITAR RIG menu under Help > Open
Manual > Your Language.

5.1 Software Installation
 

Make sure you are logged in with administrator privileges. Don’t connect the RIG KONTROL
yet.

1. Browse the content of the product DVD and locate the file GUITAR RIG Installer file. If
you are using a download version of GUITAR RIG, you need to extract the installer file
first.

2. Double-click the installer file to start the installation procedure.
3. Follow the on-screen instructions that will guide you through the installation procedure.
4. You will be asked if you want to install drivers for the GUITAR RIG audio interfaces. Se-

lect the RIG KONTROL 3 driver (this may be preselected already) and click on Continue.
5. Restart your computer upon completion.
The following applications will be placed onto your hard drive:

▪ The GUITAR RIG fully featured stand-alone software.

▪ The GUITAR RIG plug-ins: Use GUITAR RIG as a plug-in in your Digital Audio Workstation
(DAW) of choice.

▪ The Service Center: this application handles product activation as well as update manage-
ment. Please refer to the Setup Guide for details.

▪ The hardware drivers for the RIG KONTROL.

Installation under Mac OS X
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If you have never owned a Native Instruments product, you will need to register by following
the on-screen instructions. More information about creating a NI User Account and about ac-
tivating GUITAR RIG is available in the Service Center Quick Start Guide and Manual locat-
ed in the Service Center installation folder.

In case you want to install the hardware drivers only, a separate driver installer file is availa-
ble on the installation DVD. You can also download its latest version from the Support sec-
tion of the Native Instruments website.

5.2 Hardware Installation
 

Use the supplied USB cable to connect the RIG KONTROL directly to a USB 2.0 port on your
computer.

Connecting the controller to your computer.

The RIG KONTROL is powered via USB. Operation is guaranteed only with a USB 2.0 control-
ler as a single device or with self-powered USB 2.0 hubs.

► After successfully installing the driver, the RIG KONTROL will be recognized automatically.
If not, start the software installation again as explained above.

Several driver modules will be assigned to the RIG KONTROL now, each one causing a small
pop-up window notifying you of the installed driver.

Installation under Mac OS X
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If at any time the computer does not seem to recognize the RIG KONTROL, disconnect the
USB cable, wait a few seconds, then re-connect it. If the problem remains, restart your com-
puter with the interface connected.

5.3 Configuration
 

This chapter explains how to use the RIG KONTROL audio interface with Mac OS X and partic-
ularly with the GUITAR RIG software. It Is assumed that you have already activated GUITAR
RIG using the Service Center. If not, please refer to the Setup Guide for further information on
registering your product.

5.3.1 5.3.1 Configuring GUITAR RIG
 

We will now set up GUITAR RIG to use the RIG KONTROL audio interface. Start the software
before you proceed.

Installation under Mac OS X
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1. When the software is started for the first time, you will be prompted with the Audio and
MIDI Settings window automatically, where you need to make the following settings. If
you want to access these settings later, select Guitar Rig > Preferences from the program
menu.

2. On the Audio tab, choose CoreAudio as the Driver interface.
3. Select RigKontrol3 from the Device drop-down menu.

If RIG KONTROL does not appear in the list even though it is connected, something went
wrong. Restart the installation as explained in ↑5.1, Software Installation.

The audio interface allows to be configured by the following parameters:

▪ Sample Rate: Choose a sample rate that is compatible with your music application and
suited to your computing power. Per default, the sample rate is set to 44100 Hz (CD-
Quality). Higher sample rates may improve sound quality, but cause a higher CPU load as
well.

Installation under Mac OS X
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The sample rate defines how many samples are played/recorded per one second of sound. A
higher sample rate results in higher audio quality; however, 44100 Hz (as used for recording
audio CDs) is a common setting and absolutely sufficient for most tasks. If your final desti-
nation is CD, you should use this setting or a multiple of it (88200 Hz). For a better under-
standing: 48000 Hz is used by DAT recorders and for DVD (films) recording. 96000 Hz and
higher rates are typical for DVD, HD DVD, and Blu-ray Disc audio recording. You should be
aware that a higher sample rate also causes higher CPU load.

▪ Latency: Use the Latency slider to set the buffer size of the audio interface, measured in
samples. The buffer size has two effects: The higher it is set, the lower is the probability
of dropouts during real-time audio processing. On the other hand, the size of the buffer
directly affects the overall latency of your system. The time between the moment you hit a
note and the moment you hear the processed sound will be longer if the buffer size is in-
creased.

It is recommended that you start with the default buffer size and continue with the subsequent
steps of the installation. Once you are finished, you should load a clean preset and revisit the
audio and MIDI settings to figure out the best latency setting for your system. This is done by
gradually reducing the buffer size: Drag the latency slider to the left while playing something.
Once you begin to hear crackles or dropouts, carefully drag the latency slider to the right until
you reach the point where no crackles or dropouts occur.

5.3.2 Using RIG KONTROL as Your Default Audio Interface
 

If you want to use the RIG KONTROL for all audio playback (not only for music software), you
have to set it as your default audio interface. For Mac OS X, this works as follows:

1. From the Apple menu, select System Preferences.

Installation under Mac OS X
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2. In the panel that opens, click on Sound.

3. On the Sound Effects tab, select RigKontrol3 in the Play sound effects through menu.
4. Click on the Output tab, and then select RigKontrol3 from the Choose a device for sound

output list.
5. Click on the Input tab, and then select RigKontrol3 from the Choose a device for sound

input list.

5.4 Audio Connections and Levels
 

In the following chapters you will learn how to connect your guitar and your monitoring system
to the RIG KONTROL and how to set the right amplification levels both on the hardware and
on the software side of your setup. Please start GUITAR RIG before proceeding.
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5.4.1 Connecting your Instrument and Adjusting the Input Level
 

1. Turn down the volume on your monitoring system to prevent hearing damages.
2. Make sure the input selector is set to instrument input amplification (LINE/INST button

on the back of the RIG KONTROL depressed) except if you are using a preamp to boost
your signal to line level.

3. Plug the cable connected to your guitar or bass into one of the input jacks of the RIG
KONTROL.

4. Completely turn down the volume of the input channel you are not using.
Keep in mind that for an instrument that generates a stereo signal, such as a synthesizer key-
board, you need to connect it to both input channels for stereo sound.

Connecting a guitar or bass guitar to the controller.

In order to achieve the best sound quality by providing the interface with a sufficiently power-
ful signal, you need to carefully adjust the input level of the RIG KONTROL. The Input Level
Meter helps you identify the level of the incoming signal:
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Meter Status Meaning

All LEDs are off No incoming signal

Green LEDs flashing Incoming signal

Green and red LEDs flash-
ing

Incoming signal is too loud

Before adjusting the input sensitivity, turn up the volume knob on your guitar. Strum some
chords at the volume level you are typically playing at and look at the Input Level Meter:

1. Turn up the input level knob next to the input jack you chose, just until the meter is
reaching the red zone when you play.

2. At that point, slightly turn the knob down until you are safely in the green zone, even
when you are playing really powerful chords.

Now the input sensitivity is set to its optimum level, enabling the RIG KONTROL to provide the
highest dynamical range without clipping.

5.4.2 Connecting a Second Instrument
 

You can connect different instruments to both input channels, as long as they both provide a
signal at the same level (line or instrument). Just plug the cable of your second instrument into
the other input jack and set the right input level as described in the previous section.

If only one channel is used, set the other channel’s Gain knob to zero

For instruments generating a stereo signal, the second channel needs to be connected for ster-
eo sound.

5.4.3 The Input Level of GUITAR RIG
 

It is assumed that your guitar is connected to the RIG KONTROL and its input level is properly
adjusted (see ↑5.4.1, Connecting your Instrument and Adjusting the Input Level). Now you
need to make sure that the input signal is processed at the right level by the software.

Please take a look at the header of the GUITAR RIG window: It consists of the input module
with channel selectors (L/R), a basic noise gate, the output module with a limiter and informa-
tion about the processing power consumed.
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GUITAR RIG's software header.

Note that the Input Meter shows an amplitude when you are playing. It also features an inte-
grated volume fader that controls the input level of the software. Please adjust it to achieve the
highest possible level for your signal without clipping. This is indicated by the Level Meter get-
ting close to the red zone without actually hitting it.

If only one guitar is connected, GUITAR RIG will receive a mono signal. You can set up the
Input module to route your guitar signal to both channels. Per default, GUITAR RIG is set to
process both input channels (L + R are activated), so one of the input channels remains mute.
To change this, deactivate the channel you are not using: Click on the appropriate button (L or
R) on the left hand side of the Input Meter once, so that only the input channel in use is ac-
tive. This will route the mono signal to both channels.

5.4.4 Connecting the Output
 

The RIG KONTROL provides two mono outputs to connect your monitoring system, be it a mix-
ing desk, a pair of active speakers or your home stereo. Mind that both of them have to be con-
nected for stereo sound. A separate stereo output (TRS) allows for connecting your head-
phones.
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Connecting speakers and headphones to the controller.

1. Connect the output jacks to the input of your amp with its volume level turned down.
2. If you are using headphones, connect them to the output jack and put them on with the

headphone level fully turned down.
3. Go to the Preset Browser and select one of the presets by clicking on it.
4. Start playing and carefully turn up the volume of your amp or the headphone level of the

RIG KONTROL to the desired level.
You should be all set now, and ready to rock!
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6 Advanced Configuration

 

6.1 Advanced Configuration on Windows
 

You can access the driver control panel (Control Panel) by clicking on ASIO Config.in the Audio
and MIDI Settings window (File > Audio and MIDI Settings from the GUITAR RIG file menu).
In the Control Panel, a status field on the bottom shows whether the RIG KONTROL hardware
is connected and ready to use.

The Control Panel with the Audio Settings page opened.

6.1.1 The Audio Settings Page
 

In the Audio Settings page, you can configure the audio latency and sample rate; and you can
monitor the device's status. The Audio Settings page consists of two sections: Audio Process-
ing, and Device Monitor.
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Audio Processing Section

The Audio Processing section sets the parameters for the analog-to-digital/digital-to-analog
conversion done by your audio interface. It has two menus:

▪ Sample Rate: Choose a sample rate that is compatible with your music application and
best suited to your computing power. A higher sample rate improves the audio quality, but
also causes higher CPU load. By default, the sample rate is set to 44100 Hz (CD quality).

The sample rate defines how many samples are played/recorded per one second of sound. A
higher sample rate results in higher audio quality; however, 44100 Hz (as used for recording
audio CDs) is a common setting and absolutely sufficient for most tasks. If your final desti-
nation is CD, you should use this setting or a multiple of it (88200 Hz). For a better under-
standing: 48000 Hz is used by DAT recorders and for DVD (films) recording. 96000 Hz and
higher rates are typical for DVD, HD DVD, and Blu-ray Disc audio recording. You should be
aware that a higher sample rate also causes higher CPU load.

If you want to use multiple software clients simultaneously with the device, keep in mind
they'll also have to share the same sample rate.

▪ Process Buffer: Lower the buffer size value for a quicker response time from your comput-
er to audio software and MIDI controller actions.

When converting audio information to digital and vice versa, the audio driver needs to store
the data in buffer packages (audio buffers) which are then sent to and processed by the
CPU. The higher the buffer size, the longer it takes for a signal to finally arrive at the output
as audio. You might experience this as a delay between the time you hit a key on your com-
puter or controller and when you actually hear the sound. This delay is called latency. A rule
of thumb is: lower buffer size results in lower latency. However, there are more factors to la-
tency than buffer size alone (e.g., CPU speed and RAM size). You should start off with a
higher buffer size setting, and gradually decrease the value until you find the perfect bal-
ance between playability and system performance. If you experience crackling at the audio
output, the chosen buffer size is very likely too low for your computer’s CPU to cope with, as
lower buffer size causes higher CPU load.

▪ USB Buffer: Use this menu in case you cannot achieve satisfactory latency settings with
the Process Buffer menu. Lower the USB buffer size for smaller USB buffer packaging,
which should further reduce the audible latency. If you notice any audio interruptions, you
should raise the buffer size until you have a clear sound, free of dropouts.
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Device Monitor Section

The Device Monitor section displays information about the audio interface's processing status
and your system's output latency. It has two displays:

▪ Processing State: The processing state monitor provides feedback on the current status of
the device. There are three possible status messages:

◦ Idle: interface is connected, but no client delivers audio data.

◦ Streaming: driver is working and processing audio data.

◦ Panic: driver stopped streaming. Too many USB I/O errors occurred in the interface
communication.

▪ Output Latency: Shows the amount of output latency in milliseconds.

6.1.2 Diagnostics Page
 

The information provided in the Diagnostics page might be more of interest to advanced users;
however, in case of problems, you should always have a look at this page.

The Diagnostics page consists of three sections:

▪ Drop-Out Detection: displays USB I/O errors and buffer underruns when detected.

▪ Connection Monitor: displays client-to-driver connections and USB data errors when de-
tected.

▪ System Performance Test: offers the possibility to run a performance test to measure la-
tency values.

▪ Information: displays information on driver and firmware version. There is also a link to
the Troubleshooting Guide here.

Drop-Out Detection Section

The Drop-Out Detection section holds two displays and a button:

▪ USB I/O Errors: counts USB input/output errors. A high USB I/O Errors count points to
your system being overloaded.
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▪ Buffer Underruns: Buffer underruns occur when your computer isn’t able to process an
audio buffer in time. Reasons for underruns can be too many ongoing background tasks or
high CPU usage within a music program that uses the device as audio driver.

▪ Reset: A click on this button resets the error count.

Connection Monitor Section

The Connection Monitor section holds two displays and a button:

▪ Number of Clients: displays the number of clients connected to the interface. Multiple
ASIO applications are counted separately, WDM and WASAPI increase the number by
one, no matter how many WDM/WASAPI applications play audio.

▪ USB Data Errors: counts USB data errors. Poor quality or long cables as well as irradiation
can be the source of data errors on the USB bus.

▪ Reset: A click on this button resets the error count.

System Performance Test Section

▪ Current Latency: Click on the Start button below to display the current latency value here.

▪ Maximum Latency: displays the highest value that was during the current measuring cy-
cle.

◦ Clicking on Reset has the same effect as clicking on Start for the first time. It resets
the testing procedure to its beginning and starts a new test with fresh values.

◦ Clicking on Stop will end the test. The Maximum Latency value will remain displayed.

Information Section

The Information section holds two displays and a button:

▪ Driver Version: See the currently installed driver version here.

▪ Firmware Version: See the currently installed firmware version here.

▪ Troubleshooting Guide: Click Show to open the Troubleshooting Guide.
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6.2 Advanced Configuration on Mac OS X
 

On Mac OS X, all relevant settings are accessed from the Audio and MIDI Settings window. Re-
fer to section ↑5.3, Configuration for further information.
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7 Using the RIG KONTROL as a Controller Interface

 

The RIG KONTROL enhances your experience using GUITAR RIG by integrating perfectly as a
hardware controller. Aside from the built-in controller features, it offers MIDI connections and
two jacks for external footswitches and pedals. The following sections explain how to set up the
hardware to fully exploit these features. To learn how to assign functions of GUITAR RIG to
controller inputs, refer to the Getting Started Guide and the Application Reference.

To use the RIG KONTROL as a standard MIDI controller, you have to use the included Control-
ler Editor software. Please refer to the Controller Editor Manual for details.

7.1 Activating the RIG KONTROL in GUITAR RIG
 

The RIG KONTROL is activated automatically in GUITAR RIG when the hardware is connected.
The first time it is activated, a window will pop up asking you to calibrate the foot pedal.
Please press the pedal all the way up and down and confirm by clicking on OK. To recalibrate
the pedal at any time, go to the Options page and select Preferences. Click on the Reset but-
ton next to RIG KONTROL Pedal Calibration.

The RIG KONTROL hardware has a graphical counterpart in GUITAR RIG which is shown after
clicking on the Show/Hide Rig Kontrol button above the rack.

If you are running multiple instances of GUITAR RIG (e.g., in a sequencer), you may want to
define which of them is controlled by the foot pedal. By default, the RIG KONTROL is activat-
ed in the instance of GUITAR RIG you launched first. By clicking on the Connect LED on the
Virtual Kontrol in another instance, it gets the focus of the RIG KONTROL – only one instance
can have it at a time!

Some functions are assigned to the footswitches 5-8 by default, as indicated by text labels on
the hardware. You can instantly step through the presets currently visible in the browser with
switches 5 (Preset Prev) and 6 (Preset Next). Switches 7 and 8 are for activating the tuner and
tapping in a tempo with your foot. These buttons can of course be re-assigned to other func-
tions as you please.
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The easiest way to assign a button or the pedal of the RIG KONTROL to any function in the
rack is to drag it from the Virtual Kontrol and drop it on the parameter you want to control. For
a detailed description of the way controller assignments work, please refer to the Getting Start-
ed Guide and the Application Reference.

7.2 Using MIDI Controllers with the RIG KONTROL MIDI Interface
 

While being capable of sending MIDI messages to control other applications, the RIG KON-
TROL communicates with GUITAR RIG directly via USB. Nonetheless, it features a standard
MIDI interface with one input and output channel.

To use a controller connected to the MIDI input jack, make sure that the RIG KONTROL MIDI
channel is activated in GUITAR RIG:

1. Open the Audio and MIDI Settings. On Windows, they are found in the File menu. In Mac
OS in the GUITAR RIG menu.

2. Go to the MIDI tab.
3. On the Inputs table, locate Rig Kontrol and switch it on by clicking in the Status column.
The MIDI input channel is set on the Options pane of GUITAR RIG: On the Preferences tab,
click on the dropdown menu labeled MIDI channel and select 1-16 or omni. To learn how to
assign functions to external MIDI controllers, refer to the Getting Started Guide and the Appli-
cation Reference.

7.3 Using Additional Footswitches and Pedals
 

The RIG KONTROL features two jacks for connecting external footswitches and pedals with a
¼" patch cable. Once connected and set up, they can be assigned just like MIDI controllers in
GUITAR RIG. Refer to the Getting Started Guide and the Application Reference to see how.

Under Preferences on the Options page of GUITAR RIG, the following settings are available:

► To calibrate an external pedal, click on the Reset button next to Rig Kontrol Ext Pedals Cali-
bration.
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The two lines Rig Kontrol Ext Pedal 1/2 Mode allow to configure each both inputs to match
your external footswitch or pedal. Consult the manufacturer’s product specifications to find
out if it is a tip or ring active pedal, or respectively, if it is an opening or a closing switch. If
problems occur, try out the other available modes.
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8 Troubleshooting

 

Should you encounter any problems with your hardware, it is recommended that you follow
these steps to find a solution to your problem before contacting Technical Support:

▪ Visit NI’s online Knowledgebase. The easiest way to find it is by selecting Help > Visit the
Knowledge Base... from the GUITAR RIG menu.

▪ Visit the NI User Forum on our website:
http://www.native-instruments.com/forum/

When contacting Technical Support, please make sure to have all relevant information about
your computer at hand. For information about the driver’s version and the firmware revision,
please check the driver control panel:

▪ On Windows computers, you can find driver and firmware version in the RIG KONTROL's
Control Panel. Open the Rig Kontrol 3 folder from the Native Instruments software folder
and double-click the Rig Control 3 Control Panel launcher. Click on Help > About Rig
Kontrol 3 Control Panel to display the information.

▪ On Mac OS X computers, you can access the driver control panel from the system prefer-
ences. The information is shown in the main window.

Please visit this URL to contact the support team:

http://www.native-instruments.com/support/

All products by Native Instruments are tested extensively in real life situations during the de-
velopment phase. However, if your product needs to be returned, the Technical Support team
will assign you an RA (Return Authorization) number to expedite the processing of your return.
Please contact our Technical Support team prior to returning any item. Packages returned
without this RA number will not be correctly identified and as such might not be processed
efficiently.

8.1 Audio Issues
 

This section provides help with the most common audio issues you may encounter.
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8.1.1 No Sound or Low Volume
 

There are several possible reasons for a silent or low audio output:

▪ Disconnected or broken cables. Please check all connections and cables.

▪ Incorrect soundcard or audio input selected. Please check the Audio and MIDI Settings in
the GUITAR RIG menu to see if the RIG KONTROL driver is selected.

▪ Wrong channel selected in the Input module of GUITAR RIG. Connect your instrument to
the other input jack or switch to the other channel by choosing it from the user interface's
header.

▪ The RIG KONTROL’s input gain is set too low. Turn up the input level.

▪ Your instrument’s volume is turned down. Turn up the volume knob.

8.1.2 Distorted Signal
 

If the audio signal sounds distorted, and no distortion is being added by the GUITAR RIG soft-
ware, then this is most likely caused by the RIG KONTROL’s gain being set too high. Reduce
the input level at the Interface to prevent the preamp from clipping. If your instrument delivers
such a high signal that the preamp is always overdriven, you should reduce its volume. Usually
this only happens if the instrument is equipped with special high power pickups.

8.1.3 Noise
 

Audible hum can have several reasons, some of which are listed below:

▪ Single-coil pickups are prone to collecting electrical interferences. Humbucker pickups
produce much less hum, which is why they got their name.

▪ Your guitar is too close to electrical equipment. To reduce this type of hum, move the gui-
tar further away from the equipment.

▪ The guitar’s volume knob is set to a low level. Turn the knob up. If your guitar has more
than one volume knob, make sure to check all knobs.

▪ You are using a non-shielded or broken guitar cable. Your guitar’s shielding may also be
insufficient. Try replacing the cable with a shielded model first. If this does not help, you
should consider having your guitar’s electronics serviced and shielded by a professional.
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If you are experiencing hiss, the input level at the RIG KONTROL preamp might be too low.
Turn up the instrument’s volume or increase the input level on the RIG KONTROL. For more
information on setting the input level, see section 4.4 (Windows) or section 5.4 (Mac OS X) of
this manual.

8.1.4 Ground Loops
 

Ground loops (usually perceived as a hum or buzz) are a common problem when multiple elec-
trical devices are connected to the same power circuit. The following steps should help to
eliminate them:

► Disconnect all devices that you are not currently using, e.g. peripheral devices you may
have connected to your computer (external data storage, CD/DVD burners).

► Hook up a DI box behind the RIG KONTROL outputs. Most of these boxes have a ground lift
switch, which allows breaking the ground loop and eliminating the noise.

8.2 Hardware-Related Problems
 

Check the Native Instruments website and the Service Center for updates of the RIG KON-
TROL driver and more information.

8.2.1 Driver Issues
 

Make sure that the RIG KONTROL is connected to the computer and open the driver control
panel. See the intro to this chapter on how to find the driver control panel.

If the driver control panel is missing, the driver is most likely not installed at all. In this case,
please re-install the driver as described above.

If all the drop-down menus of the driver control panel are grayed out, the RIG KONTROL is not
recognized by the driver. Something might be wrong with the USB connection, see the follow-
ing sections for details.
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8.2.2 USB Issues
 

The RIG KONTROL is a USB 2.0 interface and will not work on a USB 1.0/1.1 port. Always
connect it directly to a USB 2.0 port on your computer. The port needs to fulfill the minimum
power specification for a USB 2.0 port (500 mA). On certain computers, the USB 2.0 ports do
not meet the official USB 2.0 power specification. In this case, you may see a message, saying
that there is not enough power available to operate your device. The RIG KONTROL may pro-
duce crackles or may not work at all.

▪ If your computer is unable to supply the necessary amount of bus power, try connecting
your RIG KONTROL to a USB 2.0 hub with external power-supply. Avoid connecting other
devices to the hub, as every bus-powered device will diminish the total amount of power
available.

▪ In case of failures, it is useful to check if RIG KONTROL works if you disconnect any oth-
er USB device from the computer.

▪ If you are experiencing audio dropouts or other problems that may be related to the USB
connection, try connecting the RIG KONTROL to another USB 2.0 port.

▪ A bad USB cable can be responsible for audio dropouts and/or other connectivity prob-
lems. Try using a different cable bearing the official USB logo, in some cases using a
shorter cable might help.

▪ If you are experiencing problems with RIG KONTROL crashing or performing badly on a
Windows machine, the first thing to do is to disable power management for the USB
hubs, which is turned on by default. Go to the Device Manager (Control Panel > System >
Hardware) and right click a USB hub to bring up its properties. On the Power Manage-
ment page, uncheck all boxes. Repeat for each hub and reboot.

8.2.3 Using the RIG KONTROL with a Laptop
 

Please check if your computer is suited for handling real-time audio processing without drop-
outs. There are a couple of freeware tools to analyze your system, for example:

www.thesycon.de/deu/latency_check.shtml

Start the tool with the RIG KONTROL disconnected. In case your computer is unable to handle
glitch-free audio processing, the tool will show red latency bars and report this in the box on
the bottom.
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In general, it is not recommended to use laptops with shared-memory graphic cards. You will
need all the memory and processing power available for your audio project.

There are some steps to optimize your laptop’s audio performance:

► It is not recommended to run the laptop on battery, as power management might slow the
clock rate of the CPU down, to save battery.

► Disconnect all unused hardware (e.g., printer, scanner). This will increase the amount of
processing power available for your music software.

► Laptops often are equipped with built-in devices that disturb audio processing, most com-
monly a network adapter or a wireless LAN card. You might need to disable these devices while
working with the RIG KONTROL.
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9 Technical Specifications

 

This section contains all relevant technical specifications of the RIG KONTROL hardware.

9.1 Jacks and Sockets
 

▪ 2 input jacks (In 1, In 2) for mono 6.3mm (1/4 inch) phone plugs

▪ 2 output jacks (Out 1, Out 2) for 6.3mm (1/4 inch) mono (unbalanced) or TRS (balanced)
phone plugs

▪ 1 Headphones jack for stereo 6.3mm (1/4 inch) phone plug

▪ 2 input jacks for external pedals / footswitches / switchboxes

▪ (Pedal 1, Pedal 2) for stereo 6.3mm (1/4 inch) phone plugs

▪ 2 MIDI (In/Out) 5-pin DIN circular connector

▪ 1 USB 2.0 Type B

9.2 Audio Specifications
 

Audio Inputs (A/D)  

Channels 2

Sample Rate 44.1, 48, 88.2, 96, 192 kHz

Bit Resolution 16, 24 Bit

Converter Cirrus Logic

 

Instrument Inputs  

Input Impedance 1M Ohm

Full Scale Level at Maximum Gain -11,5 dBu
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Instrument Inputs  

Maximum Input Level +16 dBu

SNR (weighted) >100 dB

THD+N 0,009%

Frequency Response +/- 0,5 dB, 20 Hz – 24 KHz

Dynamic Range 105 dB (ADC)

 

Line Inputs  

Input Impedance 44 KOhm

Full Scale Level at Maximum Gain -5,5 dBu

Maximum Input Level +16 dBu

SNR (weighted) >100 dB

THD+N 0,009%

Frequency Response +/- 0,5 dB, 20 Hz – 36 KHz

Dynamic Range 105 dB (ADC)

 

Audio Outputs (D/A)  

Channels 2

Sample Rate 44.1, 48, 88.2, 96, 192 kHz

Bit Resolution 16, 24 Bit

Converter Cirrus Logic

 

Line Outputs  

Output Impedance 100 Ohm

Maximum Output Level +6,3 dBu

SNR (weighted) >100 dB
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Line Outputs  

THD+N 0,010%

Frequency Response +/- 0,5 dB 22 Hz – 44 KHz

High/low level switch Full scale 5 Vpp / -14 dB

 

Headphone Output  

Load Impedance 8-600 Ohm

Maximum Output Level 1,61 V rms @ 100 Ohm

SNR (weighted) >91 dB

THD+N (60 Ohms) 0,013%

Frequency Response +/- 0m5 dB 22 Hz – 44 KHz

9.3 Power Supply
 

USB 2.0 interface, 5 V / 500 mA bus power. No additional power supply or battery is needed,
only power from the USB is required. However, proper operation is guaranteed only when RIG
KONTROL is used as a single device with a USB 2 controller, or with a self-powered USB 2
hub.

9.4 Dimensions and Weight
 

▪ Dimensions: 360 x 237 x 102 mm (14.1 x 9.3 x 4 in)

▪ Weight: 2.6 kg (5.7 lb)

9.5 Environmental Specifications:
 

▪ Operating temperature: 0°C to 40°C (32°F to 104°F) (85% non-condensing humidity)

▪ Storage temperature: -20°C to 50°C (-4°F to 122°F) (85% non-condensing humidity)
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9.6 System Requirements
 

▪ Mac OS X 10.6 (latest update), Intel Core Duo, 1 GB RAM, USB2.0

▪ Windows 7 (latest Service Pack, 32/64 Bit), Intel Core Duo or AMD Athlon 64, 1 GB
RAM, USB2.0
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